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Fortunately, You're 

Inefficient!
You can save at least 20 minutes every day if you read and follow this book. Welcome to 
the world of efficiency! The title says that you are inefficient, referring to inefficiency in the 
context of using Microsoft Office tools.

My apologies if you feel I am being too harsh. I'm not doubting your ability, expertise, 
domain knowledge, or experience. Just try the efficiency tests in this chapter to 
understand what I mean by "inefficiency."

When you use any software, such as Office 365, that has thousands of features, inefficiency 
is inevitable. Why so? Because you can get the same results in multiple ways. We find one 
of the ways – usually by trial and error – and stick to it. We never try to find out whether 
there is a better, faster, smarter way.

Exact probability: Let's say one activity can be done in four different ways. Only one of these 
methods is efficient. You find one of the methods. You have a 25% chance of finding the best 
method. How many activities do we perform with Office? Let's say 120. What is the chance of 
finding the best way every time? 5.6597994e-71%, which basically means zero! In fact, with 
just 7 activities, the probability drops to 0.006%.

Note
It is statistically impossible to be efficient by using trial and error.

This is the first chapter of my book
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4     Fortunately, You're Inefficient!

Why did I say "fortunately"? Because you have already taken the first step. You are reading 
this and thinking about it. Noticing the problem is the first step of solving a problem. 
By the end of this book, you will be super efficient. You will save an enormous amount 
of time, which is the immediate reward of efficiency. You can then invest that time in 
activities that drive your growth or add value to your life. That's fortunate, is it not? 

Let's begin your efficiency transformation. The main topics we will cover in this chapter 
are as follows:

• What's in it for you?

• Evaluating your inefficiency

• Inefficiency audit – how to find your own inefficiency

• Why are there so many features?

• Discovering your needs behind features

• Moving from a vicious cycle to a virtuous cycle

• Frequent questions answered

Technical requirements
The example files used in this chapter are available here in the Chapter 01 folder: 
https://static.packt-cdn.com/downloads/978-1-80107-226-7_
ExerciseFiles.zip.

There is a separate folder for each chapter. You can download the files as needed. 

What will you gain by reading this book?
You will save at least 20 minutes every day by learning and applying the skills explained in 
the book. What will you do with the time saved? Use it to your advantage!

Finish your backlog, analyze data more effectively, learn additional skills, improve your 
work-life balance, focus on your hobbies, get additional certifications – the opportunities 
are almost limitless. The only limiting factor is time. You cannot purchase time. 

But you can create time by being more efficient and use it to achieve more and grow faster 
in your chosen field.

What Is Efficiency?
Efficiency is putting in less effort and getting a better impact or more output.
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Improving efficiency is a simple, two-step process:

1. Detect inefficiency.
2. Learn how to find a more efficient method.

Most people with a PC use Microsoft Office. We usually learn how to use it by trial and 
error or on the job. Once the job is completed, nobody checks whether there is a better, 
more efficient way. That is why most activities are inefficient. 

Evaluating your efficiency
Remember – inefficiency does not mean that the method is inaccurate or wrong. Your 
output may be correct, but there is a better, faster, smarter way to do the job. If you knew 
about the better way, you could have saved time and used it somewhere else to your 
advantage.

The question is, who is going to tell you that? Is anybody checking how you work using 
Office tools? Most probably not. You must do it yourself.

Sounds complicated? Not at all. Let's do some quick tests.

Before we go ahead, let's learn exactly what inefficiency means and how much difference 
efficiency makes. We will take three examples: one with Word, one with Excel, and one 
with PowerPoint. You can choose which one you want to try.

Fitting a table in a Word doc
When we copy and paste a table from Excel or a web page, it often goes beyond the Word 
page boundary, like this:

Figure 1.1 – Table exceeding document width 
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This is a frequent problem. Do you know how to adjust it to fit on the page? Of course, 
you do. But what process did you use? Think about it.

Use the Ch1 - Table not fitting in page.docx file from the Chapter 01 
folder in the sample files.

Here is the efficient method:

1. Click anywhere inside the table. There's no need to select the table, just click  
inside it.

2. Open the Layout tab and choose AutoFit | AutoFit Window:

Figure 1.2 – Adjust your table width efficiently 

Compare this with your method, and you will know the difference.

Editing formulas in Excel
Every time we add data in Excel, we need to change the formulas that depend upon  
that range. This is repetitive work. We may not even know how many formulas we  
need to update. But we have to do this every time data is added. Is that really my job?  
Am I supposed to help Excel? Or is it the other way around?

Use the sample Ch 1 – Data and Formulas.xlsx to get the answer of the above 
question.

Note
There is a Trace Dependents option, but most of us do not know about it or use 
it regularly.
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Figure 1.3 – Data and formulas 

Now try this. After adding the data, create a table and then add formulas. Now add more 
data; the formulas will update automatically. Watch this video and see for yourself how 
easy it becomes:

https://hi.switchy.io/fyiww

Why a video? Why not just write the steps here with screenshots? Well, watching a 
video shows the real, practical way to do it. You learn faster and you can even practice it 
yourself. Short, fast, and effective.

Tip
Always use Excel tables. It saves time and promotes accuracy.

Using the Send to Back option in PowerPoint
In this presentation, we have three objects on top of each other. The object in front is easy 
to edit. But how do we quickly edit the shapes that are behind others? Think about what 
you would do… manually move them around to remove overlap, or struggle with Send  
to Back?
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Use the sample Ch1 - Send to back.pptx file from the Chapter 01 folder. 

Of course, there is a better way. Go to the Home tab | Select | Selection Pane.... Now you 
can see all the items as a list. Select the one you want and edit it. You can edit it even if you 
cannot see it.

Tip
Always keep the Selection Pane open. PowerPoint editing will become much 
simpler and faster.

Figure 1.4 – Selection Pane – your best friend in PowerPoint 

Now that we are aware of inefficiency, let's see how we can identify it.

Inefficiency audit – how to find your own 
inefficiency
I can give you many such examples. But that is not the point. How long are you going to 
depend on me? I want to make you independent and efficient. So, let me show you three 
powerful ways to find inefficient processes:

• Useless repetition

• Hands versus brain
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• Who is helping whom?

 Figure 1.5 – Find inefficiency 

Useless repetition
Repetition does not mean inefficiency. In fact, we repeatedly produce the same product  
or deliver similar service as a part of business, which we get revenue from. That repetition 
is fine.

Similarly, to manage our business, we must do repetitive things such as pay salaries, 
check quality, and submit financial reports. This type of repetition is also necessary, not 
inefficient.

But if you are doing something that is neither getting you revenue nor part of operations, 
such as manually updating each formula after adding data in Excel, that is inefficient. 

Hands versus brain
Here is an example to illustrate this issue. We have 50 numbers. We want to add a formula 
in the next column and copy it – quite a common requirement. Most people copy a 
formula by dragging.

Look at the data… for 5,000 rows of data, how long will you have to drag? 

While dragging, your hand is busy – but your brain is idle! It is not only a waste of time – 
it will soon give you arthritis!

The bottom line is, when you notice that you are just using your hands to do some 
mundane work and your brain is idle, the process is inefficient.

Who is helping whom?
Remember, any software or technology is there to help us. It is not the other way around. 
Sounds obvious, right? But think about it.

When you were dragging the table columns to fit a table onto a page or using Send to 
Back to make a shape visible, who was helping whom? Were you trying to help Word or 
PowerPoint?
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Is that your job? Absolutely not. So, learn to detect this inefficient behavior. Anytime 
you feel that you are helping (or even fighting with or struggling with) the software, that 
means your process is inefficient. It also means that there must be a better way. You just 
have to find it.

Figure 1.6 – Hands versus brain 

Is there a better, faster way? Double-click at the bottom-right corner of the cell. It 
works. Time saved. However, double-clicking is risky because it stops at the first gap it 
finds. 

The most efficient way is to select the full range once and convert it to a table by going 
to the Insert tab and clicking on Table. Now, when you add a formula, Excel will copy it 
automatically. The result? Time saved and greater accuracy. Watch the following video 
to understand this concept and the solution quickly:

hi.switchy.io/fyihb

We will now see the different features of Office we have available to find our best or most 
efficient way.
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Why are there 14,000+ features?
Yes, there are thousands of features in Office. In 2019, there were more than 14,000 
features across all the products.

What are you thinking?

• Oh, that is too much!

• I don't want all these features.

• What I need I already know. That is enough for me.

• Give me only the features I need. It is too confusing.

• This is a feature explosion!

Figure 1.7 – Underutilization 

Now, think about another number – how many features do you use?

Over the last 30 years, the answers I have received range from 10 to 130. The point is that 
your work is getting done. That is why we get the feeling that "What I know is enough."

Well, I cannot deny that. But let's think a little further. It leads to a subconscious thought – 
"What I don't know, I don't need."

Does that sound logical? Not at all. How can you say you don't need something that you 
don't know about?

That is what I call the "inefficient mindset." What if a feature could be useful for you but 
you refused to notice it?

Pro Tip
Figure 1.7 has 14,000 points plotted. I used the SandDance visual in Power BI. 
It allows you to plot thousands of points in a 3D space and even rotate them 
interactively. Try it out.

Buy this book at Amazon : Use this link s.efficiency365.com/bk or scan this QR code



12     Fortunately, You're Inefficient!

Why do we use only a few features?
When confronted with two numbers – available: 14,000 and used: 150 – what is the typical 
reaction? Most people try to defend the status quo. They tell me why 150 is enough for 
them. They may also say "my 150 may be different from your 150," and so on.

But the real question to ask is why did Microsoft create so many features? Do they not 
know about this reality? Of course, Microsoft is aware.

Adding each feature is a complex and costly process. So why is Microsoft adding so many 
features? For whom? It is for us – all the users globally – like you and me.

How to learn (to find the best way)
How do you find the most efficient solution for what you need? Without anyone to guide 
you, how do you find the best way? Usually, we find solutions using one of these methods:

• Ask someone.

• Google it.

• Search the Help file.

Unfortunately, these methods are not effective. Why?

Asking someone is useless because, most probably, that person is also inefficient! You may 
get a more efficient method from them. But who will tell you if there is an even better 
way? Why waste time?

Google results depend upon what you search for. If you do not search for the most
efficient way or the best or the most optimal way, you are not going to get 
the best answer on top, and nobody clicks on the next page. That means you are getting 
"some" answers but not necessarily the most efficient method.

In this case, the Help file is not very useful either. Why? Because for Help to actually help 
you, you need to type the name of some feature. If you do not know what the feature is, 
what will you type?

Observing the menus logically
A much simpler way is to assume that if I have a need, Microsoft must have already 
noticed it and given me a solution. It cannot be in a secret place, right? 
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What is a solution? A button, a menu option, or a dropdown. So which menu should we 
look at? The immediate answer to this question is, observe logically, and then implement 
the following:

• Observe and notice all menus logically.

• For local problems, right-click (or click on an ellipsis …).

• For global (bigger) problems, use the menu at the top, called the ribbon.

Local problem – right-clicking
Some options are on the ribbon, but some are not. The concept is simple. If it a local or 
smaller context, the options are in the right-click menu. If the context is bigger, then the 
options are in the menu at the top – the ribbon. Things related to the behavior of the 
application are in File | Options.

Once you understand this, you can find the right features quite quickly.

Here is an example. Do you want to change the color of a chart's title? This is a local 
problem, so right-click on the title – look at all the menus and toolbars that appear and 
choose the option for you.

Figure 1.8 – Menu for a local problem

The right-click menu tells you what can you do at that place. That is why it is known as 
a context menu.
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Global problems – top menu
On the other hand, if I want to change the overall design of the chart, that is a larger or 
global problem. So, I must look for the option in the top menu – the ribbon – in the Chart 
Design tab. 

Figure 1.9 – Menu for a global problem 

Here is another example. I want to change the red text to blue in this document. There are 
many places where the red text is present.

Figure 1.10 – Change red text to blue 

The first thought is to select each red area one by one and then change the color. 

Repetition + Hands (not brain) + I Am Helping Word = Inefficient Method

The problem is with selecting the red words. Word must have a solution to this problem. 
Now classify the problem: global or local?

This is a global problem because I want to select text throughout the whole document. 
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So, I need to use a menu on the top, but which menu?

All editing commands are on the Home tab. So, let's go there. 

Look at the different buttons and read their names. Do you see any options related to 
selecting stuff?

That button has a dropdown – let's open that. And amazingly, we have exactly what we 
need – Select All Text With Similar Formatting:

Figure 1.11 – Find the solution 

So I click on any red word, choose this option, and then change the color.

Figure 1.12 – Efficient way of selecting similarly formatted text

How to Find the Right Solution
If it's a global problem, go to the top menu. If it's a local problem, right-click.
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Next, we will see how to change our approach and become super efficient. Once you 
understand the concept, you can learn on your own for the rest of your life!

Other ways to learn while you work
Here are some more simple and effective ways of learning. They will become clearer as you 
cover more topics in the book:

• Observe the mouse cursor and learn: When the mouse cursor shape changes, the
behavior and the right-click menu also change. Check it out and learn.

• Always open all the drop-down menus: When there are many options but not
enough space, the options appear in a dropdown. Open each dropdown and read
the options. In fact, play a game with yourself. Try to predict the options in the
dropdown before you open it. If you get all of them right, you win. If you do not
guess some of the options, you still win, because you will now remember it very well
(a hurt ego is a great teacher!).

• When you open any dialog, open all tabs and see all the options: There is no need
to try each item. Just notice them and try to understand their significance. You do
not have to try each option in the dialog. Just think – when will it be useful?

Now let's learn the process of efficiency transformation.

Discovering your needs behind solutions/
features
If you are not from the IT field, let me explain the concepts of use case and solution. 
Whatever needs business users have are called use cases. The IT team develops a way to 
satisfy those needs. That is called a solution.

So, think about all these thousands of features. Each one of them is a solution. To what? To 
some need. Whose need? Well, we won't know the name of the person. But we certainly 
know it must be some user like you and me.

Someone somewhere requested Microsoft to solve their problem and Microsoft added 
the solution – the button or option – to Office. Over three decades, so many buttons have 
accumulated and been thrust upon us, leading to confusion.
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Figure 1.13 – Find needs behind features 

So, what can we do at our end? We know that each button is a solution. Now try and find 
the underlying need. Once you find the need, you can check whether you also have that 
need. If yes, congratulations – you just found the solution to your need!

If you find that the need is not applicable to your work, no problem. Do not use the 
feature till the need arises.

The Efficient Mindset
Find the needs behind every feature. 

Now that we are aware of all the different features we have at our disposal, let's see how we 
can use them to find our best or most efficient solution.
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Moving from a vicious to a virtuous cycle
You know how to explore the available features. Here is a recap of how to improve your 
efficiency using our simple but powerful method. 

Vicious cycle:

• We use Office every day to do various activities.

• We have limited time, and we want to use that time to grow in our career and
business.

• Each activity we perform using Office is inefficient, which means we are wasting time.

• Because we are wasting time repeatedly, we have less time available.

• This means there is no time to learn the right way or more efficient method.

• Because we are not learning we are not efficient.

• This is the vicious cycle.

Virtuous cycle:

• You find an efficient way to do something.

• That saves you some time.

• You invest some of that time into finding a more efficient method.

• That saves you even more time.

• This is a virtuous cycle.

And that is exactly what we will do in this book. Just keep an open mind, follow the book, 
and you will see the results for yourself.

Stop Ignoring and Start Exploring
Ignoring leads to ignorance. Exploration leads to excellence.

Before we proceed, let me address the most common questions I receive. You need not 
read it in detail. Just browse through the topics. Check the details only if they are relevant 
to you.

Frequent questions answered
I get these questions very frequently across countries, industries, and roles. Let's handle 
them upfront. Just browse through the questions and clarify your thoughts.
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Which apps/tools are we covering?
Whenever I refer to Microsoft 365, I am referring to all the apps available on the platform 
at the time of writing this book.

Do not let the number of tools scare you. At this stage, do not say, "I do not need all this."

Figure 1.14 – Microsoft 365 apps

As you go through the book, you will understand which app to use when and why. You 
will learn the most key features for each of these apps. You can then decide which ones are 
relevant to your work. 
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How can you cover so many tools in one book?
There are two reasons.

Firstly, we need to at least know what each app does, what need it is serving, and when to 
use it.

Secondly, we are not covering each app in detail. That would make the book too long and 
boring. The purpose of this book is to cover the "must-know" features from each of these 
tools. The objective is not to make you a pro in one tool but make you an expert in using 
the right tool in the right way.

More importantly, you will learn how to learn. This will empower you to learn on your 
own for the rest of your life!

Is this a tips and tricks book?
No. Tips and tricks are isolated, quick solutions. 

This book is not a quick fix. It is a process. It is a mindset change. It is empowerment.

The aim of this book is to make you more efficient and more effective. The topics in this 
book are handpicked to ensure that they will be relevant to common work needs.

You will learn how to use the tools in an integrated manner to minimize manual work and 
eliminate wastage of precious time.

What will we not cover?
The two Office apps we will not cover are as follows:

• Access

• Publisher

Why not? Because in a typical business context, they have lost practical utility. Agreed, 
Access is a great database, but nowadays very few people have the requisite knowledge of 
proper database design. They tend to use Access like Excel, which defeats the purpose of 
using it. Furthermore, in the early days, Excel could manage a limited number of rows, 
so Access was the natural external database. Now, with Power Pivot and data models, the 
Excel row limit and scalability constraints no longer apply. Therefore, the most common 
need for using Access no longer exists.

Publisher is designed for creating print and web graphics. It is a great tool. But nowadays, 
more popular tools exist – Canva, Spark, even PowerPoint. Therefore, I decided not to 
cover Publisher.
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Why are there so many apps? Do I need all of them?
All these apps have a purpose. Microsoft is a professional, smart, and profitable company. 
Obviously, they will not put money and effort to create apps that have no purpose or 
benefit. 

The idea is to understand that if there is an app (or a feature), it must have a purpose. It 
must be solving a problem, or satisfying some need. We must try to find those needs and 
use them to our advantage.

This book will help you find solutions to your needs.

Each topic in every chapter starts with a need and then shows the solution. If it is your 
need (requirement/use case), continue reading the topic. If not, go to the next topic. 

Also, think about whether someone else around you (colleague, boss, subordinate) has 
that need. If yes, refer them to the solution.

Do not limit your thinking to the original need or scenario. Think more and find other 
situations where the same solution/feature may be applicable.

Prerequisites
You need to have a Microsoft 365 subscription and the cloud version of Office installed 
on the desktop, preferably on Windows 10 or 11. Some features covered in this book may 
not work on the Mac version of Office.

Traditionally, Office meant Word, Excel, PowerPoint, and Outlook. Microsoft has added 
more cloud applications to the suite, such as OneDrive, Teams, SharePoint, and Forms. 
Office and these cloud applications was referred to as Office 365. If you added Windows 
10 and Security to the mix, it became Microsoft 365.

Office 365 was recently re-branded as Microsoft 365. Throughout this book, we will refer 
to it as Microsoft 365. 

You must have Office 365 E3 and Microsoft 365 E3 to follow this book. You need to 
install the desktop version of Office from the Office.com portal.

If you do not have such a license, you can sign up for a trial for Office 365 E3. Use this 
link to start the trial: https://www.microsoft.com/en-us/microsoft-365/
enterprise/compare-office-365-plans. To open the site to your country, 
scroll to the bottom of this page and choose a different location from the dropdown in 
the bottom-left corner. The free trial gives you a 1-month period to learn.

Log in to the Office.com site using your ID. In the top-right corner, click the Install 
Office button to install the right version of Office on the desktop.
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Check the version by going to File | Accounts. The version should be Microsoft 365 Apps 
for enterprise.

Figure 1.15 – Office version in File | Accounts 

If you have a different version, some of the features covered in this book will not be 
available.

Summary
In this chapter, we learned why we are inefficient. We learned three powerful ways of 
detecting inefficiency – useless repetition, who is helping whom, and hands versus brain. 
Finally, we saw how to find the right solution quickly – either through the top menu or by 
right-clicking. 

Try this every day while you are working. The more you try, the easier it will be to detect 
problems and find solutions.

Congratulations. You are already on your way to becoming super efficient.

Now we know why Office has so many features – simply because we have so many needs. 
We may not have noticed many of our own needs, but Microsoft has. Let's take advantage 
of this and become efficient.

In the next chapter, we will see how to learn features and discover the benefits of using them. 
This will help you understand the plethora of features in a logical and empowering way.
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